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What is Access?

e Microsoft Access is a relational database
management system (RDBMS).

e At the most basic level, a DBMS is a program
that facilitates the storage and retrieval of
structured information on a computer’s hard
drive.



Relational Database Management Systems

* A database management system (DBMS) is a
software program that lets you create
databases and then manipulate data in them

* |n a relational database management system,
data is organized as a collection of tables
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What it has? Q

A rapid application development (RAD) environment
complete with visual form and report development
tools.

Various wizards and builders to make development
easier.

A sprinkling of objected-oriented extensions.

A full-featured procedural programming language—
essentially a subset of Visual Basic.

A simplified procedural macro language unique to
Access.



Getting Started
Start MS Access. &y - : :

e 1
| | Save the current database object
Mew
Create new | | g ssveomeans |
I ~u | Save the current database object as a new
b |__,-I Open | abject.
Database. . ! _
| | f=| Adobe PDF
I Save I L
— 1
Save Database. Sl swens 1

Save the database in another format

Access 2007 Database

O pe n p rEViO U S |y m Save a copy that will be compatible with
i Manage » Access 2007,
saved Database. 4

gl
|

Access 2002 - 2003 Database

Save a copy that will be compatible with

8| E-mail Access 2002-2003.

Access 2000 Database

Save a copy that will be compatible with
Access 2000,

(™ [

Adding passwords Joewin
to Databases.

Close Database

L, K

| 2] Access Optjons | |K Exit Access
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The Quick Access Toolbar
provides one-click access to
commonly used commands,

The Access Window

The Microsoft Access Help
button opens the Help
window, where you can find
information about Access

such as Save.

commands and features as
well as instructions for
using them.

[+ vesmMo

View Text MNumber Currency _. . = Validation
- Bl More Fields = $ ’ %60 Indexed -
i 2 z oo
ol':j%'lt::: g::ton allows Views Add & %3 elete Pro | Formatting Field Validation
you to close and open the ( s i = = %
Navigation Pane; you might All Access Ob]EdS " o« j Tablel \ 0%
want to close the pane so 1 i i 2 The Access window is You use the window The Ribbon provides the
that you have more room on | | |£07A.. R 1D Click to Add the program window buttons to minimize, main Access commands
the S view the ahles = * (New) that appears when maximize, and close organized by task into tabs
object’s contents. = you create a new the Access window. and groups.
j Tablel Access assigns the dafaiiase or open an
defatlcnane existing database.
“Table1” to the
first new table you | [ gy default, Access The Click to Add
create. When you creates the ID column provides
save the table, you column as the another way for
give it a more primary key field you to add new
meaningful name. for all new tables. fields to a table.

The Add & Delete
group contains options
for adding different
types of fields,
including Text and
Currency, to a table.

The Fields tab
provides options
for adding,
removing, and
formatting the
fields in a table.

A datasheet displays the
table's contents in rows and
columns, similar to a table
that you create in a Word
document or an Excel

spreadsheet. Each row will
be a separate record in the
table, and each column will
contain the field values for
one field in the table.

The Navigation Pane is the
area that lists all the
objects (tables, reports, and

so on) in the database, and
it is the main control center
for opening and working
with database objects.

Datasheet view shows the
table’s contents as a
datasheet. The status bar
indicates the current view,
in this case, Datasheet view.

Record: M 1ofl ] X No Filter | S

=) £

Datasheet View
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Working with the Navigation Pane

 The Navigation Pane is the main area for working
with the objects in a database

 The Navigation Pane divides database objects into
categories, and each category contains groups
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Viewing Objects in the Navigation Pane

Database Tools

=i ¥ Speliing
M Delete ~

displays a menu with options
for grouping objects in the
Navigation Pane

f- L] - -\I
specifies that
EI.I. ﬂhiECtS in Home Create External Data
-_ﬂ, Cuit
the database Ra Copy
are displayed :
% 7 '
W IS Clipbaard a
c ) All Access Objects =1
(table icon | P——— .
Tables S
% B —-::
(query icon S
v Queries &
~ +"_5,_-| ContractList
(fnrm icon Forms P
7 j ContractData
=Y Reports =
(repﬂrt II:'Dn -l ContractDetails
'y

enter text here to find
objects in the database
containing the search text
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Tables

* Organizing data using Tables

| fields |

lCUStDr‘r‘IEr table l

l

l

records ;' -4

fr:ustﬂmerlD FirstNar‘;we LastN:ame Phn'ne

r 11005 Owen Hawes 616-392-0622
11008 Melissa Caputo 269-985-1122
11014 Amol Mehta 616-396-1972
11015 John Weiss 616-637-7783
11027 Karen O’'Brien 517-483-9244
11053 Hwan Tang 616-396-8401
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Create Tables Using Designh View

* Create Tab in the Ribbon > Table Design

(g [ I v Examplel : Databasze (Access 2007) - Microsoft Access
I'.LQ T em eem eew oeew s o
Home i Create | External Pata Database Tools Aerobat
— I I i - = .L- - =
g PivotChart — Labels L3 -
/= & I EVEEEE S| ) & i 5N R Y
e EBIananrm — {_| Blank Report == —
Table Table | SharePoint| Table I Form Split  Multiple Form Report i Report Query Query Macro
Templatesp  Lists~  Design ||| Form  Items EIMWE Forms ~ pesign QREFUWWEEM Design || Wizard Design =
Toctm = = - - Forms Repaorts Other
@ Security Warning Certain [eatOhierk S d Options...

All Access Objects

Tables
==

w

5

o
s

Ll AP

Create a new blank table in Design
view. You can add fields, set
indexing options, and perform
other advanced table design tasks.
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Defining a Field in Design View

In the Field Name box, type the name for the
field, and then press the Tab key

Accept the default Text data type, or click the
arrow and select a different data type for the
field. Press the Tab key

Enter an optional description for the field, if
necessary

Use the Field Properties pane to type or select
other field properties, as appropriate



Defining a Field in Design View

Table window after entering the first field name

Figure 2-10

Home Create Esternal Data Database Tools

I [l @ Insert Rows o | F . 5= -
E P X = L = == =

= Delete Rows
- Property Indexes = Create Data Rename/Delete Relationships Object
& Modify Lookups Sheet Macros ~ Macra Dependencies

WIEW'S Tools Show/Hide Field, Record & Table Events Relationships

Field Name Data Type
[field name entered j—»lnvoicemm == =

[ default data type )

Description

il

click to display a w
list of data types ’J

pressing the F1 key
displays Help information

Field Properties

MNavigation Pane

[ General Lackup
[ Field Size 255 i .
Farmat
Input Mask
Caption

Default Value
Validation Rule The data type determines the kind of values

properties for d Validation Text that users can store in the field. Press F1 for

Text f'l eld Required Ho help on data types.

Allow Zero Length Yes
Indexed Yes {Duplicates OK) d'E'fault propert}'

Unicode Compression  Yes Values for a TE'Xt ﬂeld
IME Mode Mo Contraol

IME Sentence Mode Nome

L Smart Tags

i D::l_gn view. F6 = Switch panes. F1 = Help. | [ S

- =
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Field Names, Data Types & Primary key

O s R - Table Tools

L

Home Create External Data Database Tools Acrobat Design

=
1 4% =y —+= Insert Rows
SN

wes —l = Delete Rows
uilder Test Validation Property Indexes
Rules 76 Lookup Column || gheet

Tools | show/Hide

\&

@ Secur Primary Key

Designate the selected field or
fields as the primary key.

base has been disabled Options...

All Acces)

I
=1 toigil : :
“ tbitem ; | MName Text [

I Physics MNumber :
& tblPersonalinfo : Chemistry Number :
Queries -3 | I e
= gryBill
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Table Window in Design View

Design view allows

you to define or modify
a table structure or the
properties of the fields

Table Tools mont : Dat
The default name for a new -~ .

table you create in Design Home Create External Data Database Tools
view is Tablel. This name

Design

appears on the tab for the SeaInsert Rows e in a table.
niew tetle: oy E = Delete Rows = b
View | Primary Builder Test Validation Property Indexes | Create Data Rena Data Rename/Delete = Relationships Object
£ =T s @N‘Ddifylookups Sheet AP b L5 Macro Dependencies You can use the
T T Show/Hide Field. Record & =cord & Table Events Relationships Description property
— - _ to enter an optional
» || =5 Tablel A X descriftliorll for a field
s o | toexplain its purpose
Field Name Data Type Descriptic —n us:gg_ A ﬁfld'f
= | Description property
can be up to 255
characters long, and its
value appears on the
status bar when you
e Tahlo In the Field Name column, you enter In the Data Type column, you select the view the table 4
18 L2P B S s the name for each new field in the appropriate data type for each new field in datasheet.
wmdow n Deslgn view is bl Wh f h bl Th d d - h
called the Table Design table. When you first open a new the table. The data type determines what
T el Table window in Design view, Field field values you can enter for a field and
grie. ) Name is the current property. what other properties the field will have.

for the Field Name, Data
Type, and Description field
properties.

The default data type for a new field is Text.

The bottom portion of
s the Table window in
= Design view is called
= the Field Properties
= w | pane. Here, you select
=" J z 2 z values for all other
s Field Pro 4 :
D fee Field Properties field properties, most
'z>' Genenal (o=l of which are optional.
After you assign a data type The purpose or
to a field, the General tab characteristics of
displays additional field the current property
properties for that data (Field Name, in this
type. Initially, most field Afield name can be up to 64 characters long, case) appear in this
properties are assigned including spaces. Press F1 for help on field section of the Field
default values. names, Properties pane.
When defining the fields in a You can display more
table, you can move from complete Help
the Table Design grid to the information about the
Field Properties pane by current property by
pressing the F6 key. pressing the F1 key.
Design view. F6 = Switch panes, F1 = Help. = B R —
| Eaalz
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Save, Open & Rede5|gn

* Save H (or AS) > ”};r'“_“’

Save As @
Type a Name - OK. [ s _
. [VStude I
MMMMM s I r
i2wg I[ Ok ]:| Cancel
Ca) b G
- * Opening a Table )
| | € Datasheet view Tool :[P_/":
, 0L |
: View : : —'_):
: 2 : : View |
Views 1 . |
L2l e Changing the Structure = | ...
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* The navigation buttons provide another way
to move vertically through the records

Navigating a Datasheet

Navigation Button = Record Selected Navigation Button Record Selected
14 First record M Last record
1 Previous record L&d New (blank) record

2 Mext record



ICT13001
ICT13002

Chemistry

- | Add New Field
69
64

Find What:  |ICT13004 v| | FindNext |
| Cancel |
Look In: Student |«
Match: Whale Field -
Search: All -
Match Case Search Fields As Formatted
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Finding Data in a Table

>

* The Find command allows you to search a table or
qguery datasheet, or a form, to locate a specific field
value or part of a field value

Find and Replace dialog box

(& . )
| value selected in the table

| datasheet
e J

-,

p
specifies that the current

field will be searched
L A

specifies that Access will

search for a match to the

entire field value
M

specifies that all fields in

the table will be searched
< x

Find and Replace | T ]
Find REF*BCE Y
Find What: | 5011 [»] | FindNext
_ | Cancel
Look In: Current field B
Match: o Whole Field | -
Search: Al |T
hﬂatch Case |¥|Search Fields As Formatted
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* With the table open in Datasheet view, click the row
selector for the record you want to delete

Deleting a Record

* |In the Records group on the Home tab, click the
Delete button (or right-click the row selector for the

record, and then click Delete Record on the shortcut
menu)

* In the dialog box asking you to confirm the deletion,
click the Yes button



Deleting a Record

Figure 3-4 Related records from the Invoice table in the subdatasheet

P

.

plus signs indicate
the table is related
to another table

Reports
B cContradDetails

p

.

minus sign appears
when related records
are displayed

.

subdatasheet with
related records from
the Invoice table

# 3104

Primary key

| Record: H 4 10f4

11087 252,000
11073 6,500
[T 4 No Filter | Search
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2 ¥ 3093 11085 5,000 7/25/2014 Residential landscape plan
* 3094 11015 5,000 7/26/2014 Front walk and drive design, residential
* 3055 11045 14,500 6/29/2014 Handicap accessibility upgrades to public housing site
-5 3097 11080 8,500 8/2/2014 Landscape design for renovation of restaurant front en
¥ 3098 11065 35,000 7/15/2014 Design of a small town park
* 3099 11067 6,500 7/25/2014 schematic landscape design for daycare center
(® 3100 11031 10,500 8/8/2014 Schematic landscape design for daycare center
=L 3101 11030 9,500 8/24/2014 Landscape design for renovation of a restaurant site
| Invoice Num - | Invoice Date - Invoice Item = Invoice Amt - | Involce Paid - Click to A
11/28/2014 Schematic Plan $2,500.00 |
12/28/2014 Permitting £1,500.00
03/14/2015 Planting Plan 4 000.00
05/15/2015 Lighting Plans £1,500.00

8/17/2014 Landscape plans for large-scale housing developmant
7/28/2014 Front walk and drive design, residential =

|| &
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Guidelines for Designing Databases

ldentify all the fields needed to produce the
required information

Organize each piece of data into its smallest
useful part

Group related fields into tables
Determine each table’s primary key
Include a common field in related tables
Avoid data redundancy

Determine the properties of each field



Guidelines for Setting Field Properties

* Choose an appropriate data type

Data Type Description Field Size

Text Allows field values containing letters, digits, spaces, and special charac- 0 to 255 characters; default
ters. Use for names, addresses, descriptions, and fields containing digits ~ is 255
that are not used in calculations.

Memo Allows field values containing letters, digits, spaces, and special charac- 1 to 65,535 characters; exact
ters. Use for long comments and explanations. size is determined by entry

Number Allows positive and negative numbers as field values. Numbers can con- 1 to 15 digits
tain digits, a decimal point, commas, a plus sign, and a minus sign. Use
for fields that will be used in calculations, except those involving money.

Date/Time Allows field values containing valid dates and times from January 1, 100 8 bytes
to December 31, 9999. Dates can be entered in month/day/year format,
several other date formats, or a variety of time formats, such as 10:35 PM.

You can perform calculations on dates and times, and you can sort them.
For example, you can determine the number of days between two dates.

Currency Allows field values similar to those for the Number data type, but is used ~ Accurate to 15 digits on the
for storing monetary values. Unlike calculations with Number data type left side of the decimal point
decimal values, calculations performed with the Currency data type are and to 4 digits on the right side
not subject to round-off error.

AutoNumber Consists of integer values created automatically by Access each time you 9 digits
create a new record. You can specify sequential numbering or random
numbering, which guarantees a unique field value, so that such a field
can serve as a table's primary key.

Yes/No Limits field values to yes and no, on and off, or true and false. Use for 1 character
fields that indicate the presence or absence of a condition, such as
whether an order has been filled or whether an invoice has been paid.

Hyperlink Consists of text used as a hyperlink address, which can have up to four Up to 65,535 characters

parts: the text that appears in a field or control; the path to a file or page;
a location within the file or pagéfand texs digfldyad @oa-ScreenTip.

total for the four parts of the
Hyperlink data type

22



Guidelines for Setting Field Properties

* The Field Size property defines a field value’s
maximum storage size for Text, Number, and
AutoNumber fields only

v Byte
v'Integer
v'Long Integer
v'Single
v'Double
v'Replication ID
v'Decimal




Changing the Format of a Field in Datasheet [’-;f
View

Figure 2-5 Contract table datasheet

Te'.'-'(t f'leld ValLJES W File Home Create External Data Database Tools Fields Table

are left-aligned J 4| ascending  F Seledtion - ﬂ = New T Totals ¥ Replace  Calibri [Detaif =11
%1 Descending V) advanced - = save ¥ Spelling ®GoTor B J U EiE EH .
Filter Refresh Find " A
: t - All~  #% Delete ~ 55 More = g selet- A-W - e EEE B
Sort & Filter Records Find Text Formatting
%
CUFI’E‘"C}F and ContractNum - | CustomerlD - ContractAmt - SigningDate - Cont'ractTvpe = Click to Add - -
Date/Time 3011 11001 $4,000.00 2/9/2013 Residential landscape plan
: 3012 11027 5300.00 2/18/2013 Consultation for backyard, residential
field values are 3015 11005 $1,500.00 3/1/2013 Schematic plan for backyard, residential
ri g ht-ali gn ed 3017 11012 $2,250.00 3/1/2013 Peer plan review for town
3020 11055 $6,500.00 2/19/2013 Landscape design for restaurant

Format of the ContractAmt field
Currency data 't)fpe W ﬁl- Home Create External Data Database Tools Fields Table

I l [53) Date & Time _‘j‘rlame & Caption v - Data Type: Currency v | Requirea ~
and Currency format ) b as 12 = " ol g
Yes/Ma = 5] Default Value Format Cumency H Unigque —
View Text Mumber Currency Delete ; f f ki ‘ Validation
. [T More Fields - i £ % * | "2 Indexed =
I Add & Delete Properties Formatting Field Validation
click to reduce the | > " ”
! u _ ContractNum - CustomerlD - | ContractAmt - SigningDate - ContractType - (Jick to Add - -
number Of decimal 3011 11001 $4,000.00 2/9/2013 Residential landscape plan Kektc ch
places d]gp[ayed 3012 11027 $300.00 2{18/2013 Consultation for backyard, residential aitaliEn sl
3015 11005 $1,500.00 3/1/2013 Schematic plan for backyard, residential the format of
3017 11012 $2,250.00 3/1/2013 Peer plan review for town the field values
3020 11055 $6,500.00 2/15/2013 Landscape design for restaurant
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Creating a Table in Design View [V-;f

* Creating a table in Design view involves
entering the field names and defining the
properties for the fields, specifying the
primary key, and saving the table structure

Design for the Invoice table

Field Name Data Type Field Size Description Other

InvoiceNum Text 4 Frimary key Caption = Invoice Num

ContractNum Text 4 Foreign key Caption = Contract Num

InvoiceAmt Currency Format = Currency
Decimal Flaces = 2
Caption = Invoice Amt

InvoiceDate Date/Time Format = mm/dd/yyyy
Caption = Invoice Date

InvoiceFaid Yes/No Caption = Invoice Faid

KasunKosala@yahoo.com Format = Yes/No
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Specifying the Primary Key in Design View

* Display the table in Design view

* Clickin the row for the field you’ve chosen to be
the primary key to make it the active field. If the
primary key will consist of two or more fields,
click the row selector for the first field, press and
hold down the Ctrl key, and then click the row
selector for each additional primary key field

* |n the Tools group on the Design tab, click the
Primary Key button



V.
Specifying the Primary Key in Design View

Figure 2-16 InvoiceNum field selected as the primary key
AT HT T
File Home Create External Data Database Tools Design

F i = Imgert Rows Sl .= 5
= = voolll= | AL
— y Dielete Rows _— -
.thHl'T'IE!I*},f KEY bUttﬂn Viewl  |Primary _.'I Property Indexes  Create Data Rename/Delete
K&y '_H-L Mod |;| Lookups chaat Macrag = BT
b & E il
c » |j Tablel
| HEF Symbﬂl ]nd]cates Fiald Name Data Type
| th t bl ‘ o k FiF InvoiceMNum Text Primary key
I\ E a EE Pr]mary E}f ContractNum Text FCII"E'igﬁ HE'.T
InvaiceAmt Currency
InvoiceDate Date/Time
InvoicePaid Yes/MNo
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* To move a field, you use the mouse to drag it to
a new location in the Table window in the Table

Design grid
Moving the InvoiceAmt field in the table structure

Moving a Field

mont ; CLESSE 14 (<

bla{:k line indi{:ates Home Create External Data Database Tools Design
- [0 | =@ Tnig t oA L = m| ] s
the new position for I 1 S j i = %= sy
. r — - =" Delete Rows e - —_
the f1'E'|.d bElr‘Ig mDVEd | View | Primary _-"I ) Property Indexes | Create Data Rename/Delete  Relationships Object
p A . Eey zgt Madify Lookups Sheet Macros = Madro Dependencie H
[ selected field j dll SR
Field Nqme Data Type Description
¥ InvoiceNum Text Primary key
| | ContractNum Text Foreign key
-0 InvoiceAmit Currency
InvaiceDate Y Date/Time
[ move pointer j—»%_lnvnirepaid Yes/No
28
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Adding a Field Between [V-;f
Two Existing Fields

* |n the Table window in Design view, select the
row below where you want the new field to
be inserted

* |n the Tools group on the Design tab, click the
Insert Rows button

* Define the new field by entering the field
name, data type, optional description, and any
property specifications



Adding a Field Between
Two Existing Fields

Table structure after inserting a row

Create External Data Databaze Tools =  Design

f O\ G T Mz B B a2

=5 Delete Rows

Wiew | Primary Builder Test Validation Froperty Indexes Create Data FenameDelete  Relationships iObject

- Key Rules ﬁ Modify Lookups | sheet Macros = Macro Dependencies
WVidws Tools o THide Field, Record & Table Events Relationships
Field Name | Data Type Description
¥ InvoiceNum Text Primary key
 ContractNum Text Foreign key
| InvoiceDate Date/Time
 InvoiceAmt Currency
InvoicePaid Yes/No
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Deleting a Field from a Table Structure

* |[n Datasheet view, click the column heading
for the field you want to delete

* |[n the Add & Delete group on the Fields tab,
click the Delete button

or

* |n Design view, click the Field Name box for
the field you want to delete

* |n the Tools group on the Design tab, click the
Delete Rows button



Deleting a Field from a Table Structure

Figure 2-31 Customer table in Design view

(" W e P D e T e Ao
Design

Home Create External Data Database Tools

..= o Imgert Rows -' == T = g
g N j =) = = i

- = Delete Rows = = )

click to delete W

the current ﬁEld J F"":'::H' 0 Modity Lookups 3*'._;:;:::!!;1‘} Indexes C:::Eﬂi—a}a F!miT::-’t;elete Relationships D:ufﬁﬂ!ennmf,
e Tools Show /Hide Field, Record & Table Events Relationehips
» | =] Customer '
Field Name Data Type Description
RlCustomeriD Text
Company Text
Last Text
First Text
Phone Number
Address Text
City Text
StateProvince Text
ZIPPostal Text
= EaxMumber Text
- Email Text
] \ = County Text
[ fields to be deleted =4 Web Page Text
/J E Nntas Tawt
= Field Propemies
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Different view of Tables @

Datasheet view —

— To view, add, edit or delete Table ~— | Home | Create
| I
PivotTable view [ View
|
— To view a table in different angles. _
Datasheet View i
PivotChart view !

. | j ‘_j‘ PivotTable View
— To draw charts against selected

fields. iLﬂ PivotChart View
Design view

— To change the structure of a Table. '
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Creating a Table in Datasheet View

ﬁ".r'E HEIdS EntEI’Ed W Hume"” Create  ExternalData  DatabaseTools | Fields - Table
and columns resized J 5] Dostearme A Name & Caption £ G s Tet © [requing &2
M AB 12 s [ veso ﬁ "5, Detault Value jl ad it Formatting * [ Unique L—ly
View  Tet Number Cumency _ Delete - Modify Modif o Validation
E i More Fields - £ 1 Field Size 255 o Expre atting - E
Vigwi Add & Delete Proghgities Formatting Field Validation
All Agcess Objects (=) « i
\] Search. Js ContractMum - CustomerlD - ContractAmt - | SigningDate - CoptractType « ClicktoAdd
[recurd (row) selector e e+ | i
B Tablet
[fie!d (column) selector values for first record
will go in this row
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The Forms group contains
options for creating a form,
which is a database object
you use to enter, edit, and
view records in a database.

The Query Wizard button
opens a dialog box with
different types of wizards
that guide you through the
steps to create a query. One
of these, the Simple Query
Wizard, allows you to select
records and fields quickly to
display in the query results.

Options in Create Tab

External Data

Home C

8 &

reate

)

Application = Table Table SharePoint

Parts ~ Des

Database Tools

RNE BT

Query Query Form Form Blank

ign  Lists v Wizard Design A Design Form EIM‘:"?
Templates Tables

Queries Fornls

»

f

3

You use the options in the
Tables group to create a

table in Datasheet view or in
Design view (which you learn

about in Tutorial 2).

The Queries group contains The Form tool
options for creating a query, quickly creates a
which is a question you ask form containing all
about the data stored in a the fields in the
database. In response to a table (or query) on
query, Access displays the which you're basing
specific records and fields the form.

that answer your question.

e e
The Form Wizard
guides you through

the process of
creating a form.

-~

d — & rReport Wizard  <—7) ¢§8 Module
A L
2l Labels —F [P Class Module
Report Report EBlank Macro . )
g \  Design Report ¥ visual Basic
Reports Macros & Code

The Reports group contains
options for creating a
report, which is a formatted
printout (or screen display)
of the contents of one or
more tables (or queries) in a
database.

The Report tool
places all the fields
from a selected

table (or query) on

a report, making it
the quickest way to
create a repaort.

The Report Wizard
guides you through

the process of
creating a report.

KasunKosala@yahoo.com

The Create tab provides
options for creating various
database objects, including
tables, forms, and reports.
The options appear on the

tab d by object type.
\a grouped by objec ype/
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‘\ - s
Home Create

Examplel : Database (Access 2007) - Microsoft Access

@ Security Warning Certain

All Access Objects v| «
Tables

e S0 o

o
s

=4 tblltem
= tblPersona
Queries
qryBill

@Z—

i il L8 i o<
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Create a new blank table in Design
view. You can add fields, set
indexing options, and perform
other advanced table design tasks.

QOpen
Design View

Impart b
Export »
Collect and Update Data via E-mail
Rename

Hide in this Group

Delete

Cut

Copy

Paste

Linked Table Manager

Table Properties
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